
 

 

An abbreviated kinemage authorship tutorial 
by Dr. Robert Bateman, University of Southern Mississippi 
 
This tutorial is suitable for a laboratory section, particularly in combination with other kinemage-
related activities the instructor might want to pursue, ie generation and examination of other 
structures, analysis of structures previously prepared by the instructor, etc. 
 
The subject of this tutorial is ricin. Ricin is an extremely potent toxin capable of crossing 
membranes and inactivating ribosomes by cleavage of ribosomal RNA. Because of its potency, it 
has historically been used in espionage, chemotherapy, etc. It is composed of two unrelated 
polypeptide chains, with the catalytic site in the A chain (killer subunit), the cell recognition site on 
the B chain, and four bound carbohydrates.  The crystal structure of the whole molecule was 
determined by Jon Robertus and colleagues at the University of Texas, and is PDB file 2AAI.pdb 
 
 
KINEMAGE 1- Overview of the molecule   
To start - a simple alpha carbon backbone kinemage 
    For an initial look at the ricin molecule, we will run a simple default script on file 2AAI.pdb.  
Launch (i.e. start) PREKIN and open 2AAI.pdb from its menu. PREKIN will ask for an output file 
name, so call the output file backbone.kin. When the first dialog box of choices comes up, accept 
the default "Backbone browsing script", which will execute a simple script producing Calphas (a 
connected series of alpha carbons), disulfides, and non-water het groups for all subunits in the file. 
A ‘het’ group is anything not part of the polypeptide (or polynucleotide) chain. When PREKIN is 
done, it will launch MAGE so you can look at the resulting kinemage. 
 
You should see Calpha backbones for the two ricin chains in different colors, with yellow 
disulfides and several bound sugars (pink).  Move the image around by dragging with the mouse.  
Such a simple, default kinemage shows many of the features of the structure, and is useful for many 
purposes.  
 
Choosing and saving views in MAGE 
    In this section you will prepare a 3-D portrait of the entire ricin molecule and similar portraits of 
each of the two individual subunits (chains). 
    Creating an overview: First move the image around to find a view that spreads out the three 
domains in the plane of the screen, with the A chain (the white one) at the top.  See if you can 
enlarge the zoom factor by one or two arrow-clicks on the zoom slider without going off the screen 
edges.  Type ‘s’ on the keyboard to toggle into stereo, to make sure your zoom and orientation 
allow seeing most of the important parts in stereo (you can check for that, even if you can't see 
stereo yourself). Re-center if needed by checking the “pickcenter” box in the bottom right corner, 
clicking on the atom you want in the center of the screen, then unchecking the “pickcenter” box. 
Try using the keyboard keys ‘x’ and ‘z’ to move the center toward or away from you.  Once 
satisfied, choose “Keep Current View” under the Edit menu, and save as View 1, giving it a 
descriptive viewID such as "overview".  Move the image, then choose View1 under the View 
menu, which should reproduce the view you just saved. 
   



 

 

    Creating views of subunit features: Pickcenter near the middle of the A chain and zoom in 
somewhat.  Choose the "Find" function under the Tools menu.  In the dialog box, turn on 
pickcenter and ask to search for " 177 ", which is the active-site Glu of ricin;  MAGE will center on 
Glu 177 and mark it. Turn off pickcenter.  Choose a view for the A chain that shows both the 
central beta sheet and this active-site Glu, and save it as View2, with a viewID of "A chain".  Now 
pickcenter between the two domains of the B chain, zoom in, and save a view that shows the 
domains fairly equivalently, in a vertical orientation to allow for stereo. It might help to unclick the 
A chain button so you can see the B chain better, although your view shouldn’t absolutely require 
that since your readers may not think of doing it. 
 
Renaming and coloring groups: Turn on "Show Object Properties" (Edit menu), and click on any 
sugar.  The resulting dialog box will show you the program's internal data structure for this item.  
Edit the group name to "sugars", and click on the "dominant" option below it (which will hide its 
subgroup and list buttons on the button panel).  Accept the result, and see how the buttons have 
changed. In the same way, edit the group names for the protein, from 2aai 1 and 2 to "Ricin A ch" 
and "B chain" (remember that you only get about 11 characters for a group button name). Turn off 
“Show Object Properties”. 
 
   Turn on "Change Color" (Edit menu), then click on a sugar atom.  Pull down the color-choice list 
and release on white, and Accept.  Now you need to change the colors of the two subunits, A to 
differ from the white sugars and B to contrast better with the yellow SS bonds.  The "tint" colors 
work best for Calpha backbones, because they can be distinguished without overwhelming small 
features you want to emphasize.  Make the A chain yellowtint and the B chain greentint (try out 
some other possibilities, too).  
 
Saving your modified kinemage: Choose "Save as", under the File menu;  you will be given a 
dialog box to place and name the saved file. Stick with the same name (backbone.kip). You will 
notice that the file ends in ".kip" rather than ".kin".  The kip simply means that it is a modification 
of the original kinemage. Quit out of MAGE.   
 
Highlighting important features of the protein 
    In this section you will highlight the postranslational glycosylation of the ricin molecule, all of 
which occurs on the B chain. Like many secreted proteins, the carbohydrates in ricin are all "N-
linked", i.e. bound to Asn sidechain nitrogen atoms.  First, however, you will highlight one 
important feature of the active site of the ricin molecule, the active site Glutamate 177 sidechain in 
the A chain. 
 
   Adding the active site Glutamate: Use PREKIN to open the 2AAI.pdb file again, but this time 
name the output file “Glu177.kin".  In the initial dialog box of PREKIN, choose "New Ranges".  In 
the range dialog specify both start and end residue as 177, check the 'sc' (sidechain) and 'at' (balls 
for non-C atoms) boxes, the "OK accepts and ends ranges" button, and the OK button.  In the 
following dialogs accept the defaults for no focus and 0.2A balls. In the last dialog window ask for 
"only first subunit" by making sure both entry windows have a 1 in them and the middle radio 
button is checked.  When the program quits running, you have generated a side chain for Glu 177 
of the A chain. Launch MAGE with this kinemage. You should see the Glu 177 sidechain floating 
in space. Exit MAGE. 



 

 

 
Merging files in MAGE:  Now launch MAGE with your backbone.kip file, then choose "Append" 
on the File menu to add in the Glu177.kin.  This merges the two kinemages into one. Change the 
color of the Glu 177 sidechain vectors to something bright, contrasting, and oxygenish, such as 
pink or hotpink. Rename the appropriate 2AAI button as Glu 177. 
 
   When finished, look at the resulting kinemage to see if you did what you intended and whether 
you like the results.  Modify views if needed, and note anything that needs to be changed during 
future editing. Before you save the completed kinemage, return to view 1 and make sure all of the 
buttons needed for this initial view are checked. Save the completed kinemage as ricin1.kin. 
 
KINEMAGE 2- Secondary Structure in the A Chain 
 
Highlighting secondary structure with ribbons 
   The alpha helices and beta sheets are easiest to visualize by portraying them as ribbons, which is 
an artificial but useful construct. PREKIN has a built-in script which reads the secondary structure 
information at the top of the original PDB file and uses it to construct the ribbons for the backbone. 
 
 Running the built-in ribbon script: Make a new kinemage by launching PREKIN and again 
selecting the 2AAI.pdb. Save output in the desired directory with the name “ricin2.kin”. Select the 
“built-in scripts” menu, then the “ribbon: HELIX_SHEET” option. Accept all defaults in the 
“ribbon” box. In the “run conditions” box only select the first chain (A chain) by clicking the 
middle radio button and then OK. When done and before exiting, select “new pass” under the file 
menu and again select “built-in scripts”. This time select the “mcHb” script. OK and again select 
the first subunit in the “run conditions” box. Launch MAGE at the end to see the created kinemage. 
You will have two representations of the A chain overlaid. In the ribbon structure, sheet strands 
should be green arrows and alpha helices gold spirals. Irregular secondary structure, i.e. coils and 
turns, will be connecting ropes. In the mainchain structure you will see the peptide backbone and 
hydrogen bonding.  
 
Using animations as alternate views of structure 
   Animating between two different representations of an object can be very informative, even more 
so if they have different conformations.  You have made two different representations of the ricin A 
chain: a line tracing of the peptide backbone, and a ribbon diagram of the secondary structures.  
Next you will overlay and animate between these two representations.  MAGE allows animations 
between groups simply by placing an asterisk in front of the group name. 
 
   While viewing ricin2.kin in MAGE you can set up an animation between the two versions of the 
A chain. Unclick the mainchain button, leaving only the button designating the ribbon structure 
checked. Now change the name of the ribbon structure from “2AAI” to “*ribbons A”. The asterisk 
must be all the way to the left in the group name box. Accept changes. Next turn off the “ribbons 
A” button and click the mainchain button to turn on the backbone of the A chain. Change the group 
name to “*mainchain”. Accept changes and turn off “Show Object Properties”. You have now 
created an animation between two representations of the A chain. Hit the ‘a’ key on the keyboard or 
click the ANIMATE button on the kinemage to alternate between the structures. Save some good 
views of the helices and the central beta sheet. Is the sheet parallel or antiparallel? Can you follow 



 

 

the polypeptide chain as it wanders in and out of the beta sheet? Can you pick out the secondary 
structure in the mainchain kinemage alone? 
 
 
KINEMAGE 3 - Active site, with hydrogen bonds, and a rotatable sidechain 
    The philosophy behind kinemages is that the most revealing way to illustrate what is important is 
to remove extraneous parts of the structure. In this kinemage, you will concentrate on the active site 
of ricin, which resides solely in the A chain. To see what is going on at the active site, you will 
eliminate everything that is not within 12 angstroms of the critical active site residue Glu 177, 
which you highlighted in the first kinemage.. 
 
Generating an active site with the Focus option 
  Run PREKIN on file 2AAI.pdb again, with output file actsite.kin.  Choose “New Ranges” , then 
check the ‘mc’, ‘sc’, ‘at’ and the ‘OK accepts and ends ranges’ buttons. Hit “OK”. In the next 
dialog box, choose to do the focus on a residue by number.  In the "Focus Point Values" dialog, 
specify residue 177;  for radii try 8A for sidechains, 12A for main chain, and 0 for everything else;  
ignore the special logic controls.  Do only first subunit.   
 
Drawing hydrogen bonds: Choose and keep a view that gives a good close-up of the active site.  
Find the sidechains Glu 177 and 208, as well as the Gln, the two Tyr, the Arg, and the Trp that 
surround the two glutamates.  In "Draw New Setup" set “shorten lines” to 0.7 and check "line ends 
unpickable".  Turn on "Draw New", and draw in the Hbonds from the sidechains of Arg, Trp, and 
one Tyr to the closest mainchain carbonyl oxygens  (the carbonyl of the peptide bond). It is helpful 
to zoom in on each side chain and measure the distances to the nearest oxygen. Remember that 
Hbonds are 3Å or less between atoms that share the hydrogen. 
 
    Save views of two or three sidechain hydrogen bonds, remembering to use descriptive titles for 
each view. Finally, save the modified kinemage to your hard drive as ricin3.kin.  
 
This abbreviated tutorial is now complete. Hopefully you now understand a bit more about how 
proteins are "put together".  
 
 
 
 
What went wrong? 
 
I double clicked the PDB file and nothing (or something strange) happened.  The PDB file is just a 
text file and doesn’t do anything by itself. You have to either drag and drop it on PREKIN, or open 
PREKIN and select the PDB file. 
 
I can’t find my file? I know I saved it! You probably saved it to a different directory accidentally or 
perhaps the .kin extension was not automatically attached. Use the “find” function in either 
Windows (under Start) or Mac (under File) to locate your file. Also, don’t try saving over files of 
the same name. Just give your file a new name and go back to clean up old files later. 
 



 

 

I have ribbons on both chains instead of just the A chain. You forgot to check the middle radio 
button on the subunit dialog box in PREKIN. (The default is to do all subunits.) The easiest thing to 
do is just to trash the ribbon kinemage you have and take a minute to make a new ribbon kinemage 
with PREKIN. 
 
I get a blank graphics screen in MAGE when I open my kinemage.  One possibility is that you are 
trying to open a PDB file (.pdb extension) instead of a kinemage (.kin or .kip extension). MAGE 
will not read PDB files. Another possibility is that you tried to make a kinemage with PREKIN 
using another kinemage as an input file. PREKIN will only use PDB files as input files. If your text 
box says something about EOF being reached, this second possibility is your problem. Start over 
and select a PDB file for PREKIN. 
 
I put in the astericks but my animation still doesn’t work. The usual problem here is that there is a 
space in front of the asterick in the “show object properties” dialog box. Delete that space and your 
animation will work. Note that the animation is a simple switching between two structures, not a 
television production. 
 
I made my sidechain.kin file, but it doesn’t seem to have any asparagines in it. It seems to have 
prolines and other stuff.  Sounds like you either didn’t put 2 in both subunit boxes or didn’t make 
check the top radio button on the subunit dialog box in PREKIN when you made the Asn  
sidechains. It was probably still set for the first subunit based on the Glu 177 you did on the first 
pass. Trash the sidechain.kin and make it again using the correct subunit dialog box settings. 
 



 

 

Quick List of Frequently Used Kinemage Features 
 
Measuring distances between atoms – In MAGE click on the first atom. At the bottom of the 
graphics window will be the identity of that atom. Now click on the second atom. The bottom of 
the graphics window will now contain both the identity of the second atom and the distance from 
the first to the second atom in angstroms. 
 
Coloring groups – Turn on “Change Color” (Mage Edit menu). Click desired group in graphics 
screen, choose color from menu, and accept. Turn off  “change color”. 
 
Centering features – Turn on “pickcenter”, click an atom of the feature you want centered, then 
turn off “pickcenter”. Alternatively, you can hit the ‘f ’ key to enter flatland, then use your mouse 
to drag the image wherever you want. Hit ‘f ’ again to leave flatland.  
 
Animating groups – Turn on “Show Object Properties”  (Mage Edit menu), select the first group 
in the animation, and put an asterick in front of the group name. Do this for each group in the 
animation sequence. (Note: The asterick must be all the way to the left in the group box.) 
 
Eliminating unwanted features – Turn on “Prune” (Mage Edit menu), then click on the atoms of 
the feature you want to remove.  
 
Exploring a structure – To poke about a structure looking for interesting features, it is 
recommended that you make a kinemage using the ‘lots’ script in “New Ranges”. This will use all 
of the information from the PDB file to make one kinemage. It will be crowded, but you can turn 
groups on and off to explore.  
 


